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1. Insert dataset into excel.
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Figure 1: Import Dataset2

Under the Data tab, in the Get & Transform Data group, click From Text/CSV. Then,
click import in the dialog box to import the text file Dataset2 into the excel worksheet.
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rections  File Origin Delimiter Data Type Detection g
1200: Unicode ~ | | Tab ~ | | Based on entire dataset - &
CUSTOMER ~ PRODUCTS  SALESPERSON  SalesRegion  Target SALES SALESYEAR  SALESMONTH  SALES QTR
E 93 SpeedMart | Flour saharulnizam North 11681 15681.32 2020 | Apr a2 " s
1 99 speedMart  Flour saharulnizam North 61690 89032.32 2020 | Jun Qz I
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99 SpeedMart | Flour Saharulnizam North 60150 74473.74 2020 | Oct Q4
99 SpeedMart | Flour saharulnizam North 43948 48816.135 2020 | Dec Q4
93 SpeedMart | Flour Saharulnizam North 69301 65906.415 2020 | May a2
99 SpeedMart | Flour saharulnizam North 35258 | 24770.205 2020 | sept a3
Aeon Mall Flour Hadirah West 64416 108643.86 2020 | Nov Q4
Acon Mall Flour Hadirah West 62753 96949.755 2020 | sept Q3
Acon Mall Flour Hadirah West 64258 80262.72 2020 | Dec Q4
Lotus’s Flour saharulnizam North 53728 | 114692.535 2020 | Mar a1
Lotus’s Sugar Saharulnizam North 51662 | 21993.165 2020  May Q2
Lotus's Sugar Saharulnizam North 52913 22315.5 2020 | Apr az
Lotus's Cooking Oil | Saharulnizam North 69554 | 111666.24 2020 | Jul a3
Lotus's Sugar Thanneermalai  North 66365 | 114843.915 2020 | Feb a1
Lotus's Cooking Oil | Saharulnizam North 66761  113638.095 2020 | Apr a2
Lotus's Milk Thanneermalai  North 63233 105134.715 2020 | Dec a4
Lotus's Milk saharulnizam North 60780 97531.785 2020 | sept Q3
Lotus's Milk saharulnizam North 10518 17805.42 2020 | Feb a1
Lotus’s Cocking Oil | Thanneermalai  North 63163 96592.185 2020 | Dec Q4 v
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Figure 2: Load Dataset2

In the preview dialog box, change Data Type Detection to Based on the entire dataset.
Select Load to load the data directly to a new worksheet.
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£l [cusTomer B probucts B saLEs PERSON B Sales Region B Target B saLes I saves vear B saLes MoNTH B sALES QTR 2 | Queries & Connections X
2 99 SpeedMart Flour Saharulnizam North 11681 15691.32 2020 Apr Q2
3 |99 SpeedMart Flour Saharulnizam North 61600  89032.32 2020 Jun @ Queries | Connections
4 99 SpeedMart  Flour Saharulnizam North 10000 13068.27 2020 Jul Qa3 1 query
5 99 SpeedMart Flour Saharulnizam North 69399 90415.62 2020 Nov Q4
6 |99 SpeedMart Flour Saharulnizam  North 60190 7447374 2020 Oct Qs [ Dataset2 (&
7 |99 SpeedMart  Flour Saharulnizam North 43948  48816.135 2020 Dec Q4 323 rows loaded.
8 99 SpeedMart Flour Saharulnizam North 69301  65906.415 2020 May Q2
9 99 SpeedMart  Flour Saharulnizam North 35258 24770.205 2020 Sept a3
10 |Aeon Mall Flour Hadirah West 64416  108643.86 2020 Nov a4
11 Aeon Mall Flour Hadirah West 62753  96949.755 2020 Sept Q3
12 | Aeon Mall Flour Hadirah West 64258 80262.72 2020 Dec a4
13 |Lotus’s Flour Saharulnizam North 53728 114692.535 2020 Mar Q1
14 |Lotus’s Sugar Saharulnizam North 51662 21993.165 2020 May Q2
15 |Lotus’s Sugar Saharulnizam North 52913 22315.5 2020 Apr Q2
16 | Lotus’s Cooking Oil Saharulnizam North 69554 111666.24 2020 Jul Q3
17 |Lotus’s Sugar Thanneermalai North 66365 114843.915 2020 Feb Qi
18 | Lotus’s Cooking Oil Saharulnizam North 66761 113638.095 2020 Apr Q2
19 |Lotus’s Milk Thanneermalai North 63233 105134.715 2020 Dec Q4
20 |Lotus’s Milk Saharulnizam North 60780 97531.785 2020 Sept a3
21 |Lotus’s Milk Saharulnizam North 10518 17805.42 2020 Feb Qa1
22 |Lotus’s Cooking Oil Thanneermalai North 63163  96592.185 2020 Dec Q4
23 |Lotus's Cooking Oil  Saharulnizam North 14625 14373.27 2020 Feb Qa1
24 |Lotus’s Cooking Oil Saharulnizam North 61116 100196.595 2020 Nov Q4
25 |Lotus's Milk Saharulnizam North 41338 58003.335 2020 Mar Q1
26 |Lotus's Sugar Saharulnizam North 44371 46713.78 2020 Jun Q2
27 |Lotus's Cooking Oil Saharulnizam North 68652 83893.23 2020 Aug Q3
28 |Lotus's Cooking Oil Saharulnizam North 63547 82682.19 2020 Jun Q2 v

Dataset2 | Sheetl @ HR} »

Ready T Accessibilty: Good to go ] M -—— 100%

Figure 3: Output of importing Dataset?

Once the data is successfully loaded, it will be displayed in the worksheet as shown in
Figure 3. There are 323 rows loaded.

2. Create pivot table
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Figure 4: Create pivot table

Under the Insert tab, click Pivot Table. In the dialog box, choose options as Figure 4 and
click OK. An empty pivot table and its field will be displayed in the new worksheet as
follows.
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Figure 5: Blank PivotTlable and Pivotlable Fields

3. Create charts
a. Monthly Sales chart
Drag and drop fields into the areas. SALES and Target into Values and SALES
MONTH into Rows. The pivot table will be created as shown in Figure 7.
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Figure 6: PivotTable Fields



Row Labels

- |Sum of SALES Sum of Target

Jan 1800734.035 1398098
Feb 1750189.005 1427376
Mar 1984328.19 1463389
Apr 1636026.3 1262984
May 1833803.09 1522884
Jun 1678793.76 1430182
Jul 1819189.505 1541226
Aug 1258810.83 1074728
Oct 1955825.675 1439388
Nov 1932883.52 1531384
Dec 2152472.06 1684693
Sept 2016947.97 1593556
Grand Total 21820003.94 17369888

Figure 7: PivotTable

In the PivotTable Analyze tab, choose PivotChart, choose Area and click OK to
create a Stacked Area chart.
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Figure 8: Create Stacked Area chart




Double click the chart and Format Data Series and a task pane will appear. From

here, we change the fill color of Sum of SALES and Sum of Target of the chart as

desired.
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Figure 9: Format Stacked Area chart Fill Color
Right click on the grey button, click Hide All Field Buttons on Chart.
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Figure 10: Hide All Field Buttons on Chart



Click + button and check the Axes, Chart Titles and Legend of the Chart
Elements. Position the legend and title on top of the chart as in figure 11. Change
the total as ‘Monthly Sales’.
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Figure 11: Format Chart Elements
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Drag and drop fields into areas below it. Sales Region into Rows and SALES into

Values. A pivot table

will be created like in Figure 13.
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Figure 12: PivotTable Fields



Row Labels - |Sum of SALES
East 5272561.52
North 5782605.735
South 5068258.515
West 5696578.17
Grand Total 21820003.94

Figure 13: Pivot Table

In the PivotTable Analyze tab, choose PivotChart, choose Pie and click OK to
create a Pie chart.
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Figure 14: Create Pie Chart

Click the pie chart series and format the Color and Pie Explosion in the Format
Data Series. A pie chart as in Figure 15 will be created.
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Figure 15: Region's Pie Chart

c. Customer chart
Firstly, drag and drop each of the following fields CUSTOMER and SALES into
the area section below. The pivot table should look like Figure 16.
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Figure 16: PivotTable Fields



Row Labels ~ Sum of SALES
99 SpeedMart 1956282.435
Aeon Mall 2919380.265
Food Republic 3430043.385
Jaya Grocer 2777197.905
Lotus’s 3826323.3
Mydin 5068258.515
Shoppee Mall 1842518.135
Grand Total 21820003.94

Figure 17: Pivot Table

In the PivotTable Analyze tab select the PivotChart. Select the Pie section then
choose Bar of Pie then click OK to create the pie chart.
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Figure 18: Create Bar of Pie Chart

Next change the title to Customer chart and hide all the field buttons on the chart.
Inside the Format Data Labels select the percentage to have a better view on the
sales percentage of each customers.
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Figure 19: Customer s Bar of Pie Chart

d. Salesperson chart
Drag and drop PRODUCTS, SALESPERSON and SALES fields as follows.

A pivot table will be created as in Figure 20. A pivot table will be created as in
Figure 21.
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Figure 20: PivotChart Fields



Sum of SALES Column Labels -~

Row Labels ~ Cooking Qil Flour Milk Sugar Grand Total

Armirani 318982.455 420286.995 168425.91 ©34899.465 1542594.825
Fatima 313810.74 217972.845 531783.585
Hadirah 1003417.11 1193477.31 712535.22 1225137.915 4134567.555
Loh Yew Chong 1236867.465 1176358.32 1306892.305 1020659.845 4740777.935
Nalini 1138519.845 474678.09 1005811.785 906653.97 3525663.69
Saharulnizam 1268227.7 1040760.99 839137.185 615445.195 3763571.07
Tee Hui You 300533.67 469151.415 514363.14 277962.39 1562010.615
Thanneermalai 351274.68 327641.13 496517.265 843601.59 2019034.665
Grand Total 5617822.925 5416164.99 5043682.81 5742333.215 21820003.94

Figure 21: PivotTable

In the PivotTable Analyze tab, choose PivotChart, choose Stacked Column in

Column and click OK.
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Figure 22: Create Stacked Column chart

Click on the pivot table and sort it under the Data tab. Choose Largest to Smallest
in Sort Options.
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Figure 23: Sort Data

Under Format Axis, choose Axis Options and change Display units to Millions.
Next under Number, change Category to Number and Decimal places to 0.
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Figure 24: Format Axis Options
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Figure 25: Format Axis Number

Right click on the grey button, click Hide All Field Buttons on Chart. Click +
button and check the Axes, Chart Titles and Legend of the Chart Elements.
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Figure 26: Format Chart Elements
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Sales Trend chart

Drag and drop SALES YEAR, SALES MONTH and SALES fields as follows.
A pivot table will be created as in Figure 26. A pivot table will be created as in
Figure 27.
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Figure 27: PivotChart Fields

Row Labels ¥ | Sum of SALES

=2020 12089948.36
Jan §95121.455
Feb 952593.885
Mar 1097572.86
Apr §98809.615
May 987750.585
Jun 918419.85
ul 996588.045
Aug 844524.225
sep 1062939.465
oct 1087126.325
Nov 1250867.85
Dec 1097634.185

=201 9730055.585
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Feb 797595.12
Mar 886755.33
Apr 737216.685
May 846052.505
Jun 760373.91
sl 822601.46
Aug 414286.605
sep 354008.505
oct 868699.35
Nov 682015.67
Dec 1054837.365

|Grand Total  21820003.94

Figure 28: Pivot Table



In the PivotTable Analyze tab, choose PivotChart, choose Line graph in the Line
section and click OK.
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Figure 29: Create Line graph

Under the Format Data Series, change the Color to yellow and the Compound
Type to Thick Thin. Next select the Smoothed Line as shown in Figure 23..
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Figure 30: Format Data Series (Line)

Then select the Marker section at the same format series, choose the Solid Fill and
change the color as shown in Figure 24.
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> Marker Options

~ Fill
No fill
Solid fill
Gradient fill
Picture or texture fill
Pattern fill

Automatic
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Figure 31: Format Data Series (Marker)

Right click on the grey button, click Hide All Field Buttons on Chart. Click +
button to unselect Legend and select Data Labels. Lastly, rename the graph to
Sales Trend just like Figure 25.
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Figure 32: Sales Trend Line Graph



f. Create Dashboard
Firstly, create a new sheet and copy paste all the charts that we created previously

into that sheet and arrange it nicely in order just like Figure 26.
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Figure 33: Sheet contain all charts

Clicking one of the charts and going under the PivotChart Analyze tab select
Insert Slicer. Then select the slicer that we wanted such as SALES YEAR,
SALES REGION, PRODUCTS, CUSTOMER and SALES PERSON then click
OK. Figure 27 shows the Slicer selection.

Insert Slicers ? X

Figure 34: Slicer Selection




Next click the Multi Select button on each slicer so can select more than one
selection on each slicer as shown in Figure 28.

SALESYEAR 7= B

| 2020

[ 2021

Figure 35: Multi Select on Slicer

Arrange all the slicer to the side of the dashboard and change the color according
to the theme.
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Figure 36: Sheet contain all charts and slicers

Click each Slicer and under the Slicer tab select Report Connection. Then tick all
the Pivot Table to ensure the Slicer can link to other charts in the dashboard as
shown in Figure 30.
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Figure 37: Slicer Report Connections



Lastly, select all the cells and Fill Color to create a background with selected
color. Then add the report header to finalist the dashboard. The complete
dashboard is shown in Figure 31.

SALESYEAR [7=| %

ii

Sales Region %

in

South

PRODUCTS

Cooking Oil

Flour

it

apr May

= SumofTarget  m Sum of SALES

sep

Customer Chart Salesperson  sugar Shoppee Mall
" 0 s =il
= 98 spesdiart
N = Four
= asnml g
- Faod Republic 2 = cocking i
el BB ini.
o
- Lotus's .
£ oo & N
= Mydin a"'& Q,é’ f & (‘&-9’ v@@ Q‘a"
¢ T &
- shoppee hzll J“A & 8

5n o Feb  har apr
2020

May Jum i AUE Sep O Nov Dec | Jam  Feb Mar Apr May lm Ul Aug Ssp Ot Mow Dec

2021

Figure 38: Complete Dashboard

g. Dashboard Testing
Now we can test our dashboard with random input data. If we select only the sales
person “Loh Yew Chong”, then the dashboard will show all the information about
the person in all charts as shown in Figure 32.
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Figure 39: Loh Yew Chong Sales Performance



Next we try to select multiple slicers to observe the dashboard changes. In this
case we select Cooking Oil and Sales Year 2021 to see the information in the
dashboard.
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Figure 40: Cooking Oil Sales in 2021



